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Introduction
Bucket Pops is a software instrument plug-in for Microsoft Windows (VST) and Apple 
macOS (VST/AU) simulating the classic KORG® Mini Pops-7 Rhythm Machine from 
1966. It is written in native C++ code for high performance and low CPU 
consumption. The main features are:

● 20 original rhythms
● 15 modeled drum instruments (no samples)
● Tweakable instrument parameters
● Tweakable rhythm sequencer
● Resizable user interface (not “N” version)
● All parameters can be controlled by MIDI controllers
● Plug-in supports Windows and macOS (32 bit and 64 bit)

Bucket Pops is based on the new iPlug2 framework maintained by Oli Larkin and 
the iPlug2 team. Big thanks, guys!!! Without your work it would not have been 
possible to create a resizable user interface.

To resize the plug-in you just grab the yellow triangle at the bottom right of the 
Bucket Pops window and drag it. You can save the current window size using the 
menu entry “Save Window Size” in the Options Menu.

The KORG Mini Pops-7

If you have no idea what the Mini Pops-7 is or how it sounds, just put Jean-Michel 
Jarre’s classic Oxygene or Equinoxe long players on your turntable, press “Play” and 
wonder what has produced most of those funky drum/percussion sounds – this is it!

You are not fond of Rumba? Well, I never heard a more impressive “Rumba” pattern 
than that at the very beginning of Oxygene Part 6 where the Mini Pops-7 slowly 
blends into the artificial sound of sea waves, bird cries, and Eminent strings.

Released in 1966 (!) the Mini Pops-7 was not the first but became one of the most 
iconic rhythm machines – not a drum computer because there is no computer inside. 
The twenty different rhythm patterns are fixed (although it is possible to combine 
them) and hard-coded into a Diode Matrix, the early version of a ROM (Read-Only 
Memory). You won’t find any integrated circuits inside the clunky box, everything is 
realized using discrete electronics.

The Bucket Pops

Why should one want to recreate the Mini Pops-7 as a software instrument? Because it 
is so much fun – not only the playing (well, you just can select a rhythm and press 
“Start”...) but the doing (sorry that I cannot share this kind of experience with you!). 
It took me some time to decipher the rhythms from the diode matrix and it would 
have taken even longer if the KORG engineers had not put some hints into the 
schematics. I also simulated the 15 individual instruments using LTspice to get the 
sound right. I don’t ask you to understand my motivation. 

Mind that each original Mini Pops-7 sounds different due to various internal trimpots, 
tolerances and aging of the electronic components etc. In the Bucket Pops you can 
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tweak the instruments beyond recognition, and you can change the rhythm patterns 
themselves, too!

The Bucket Pops “N” Version

Many users with older operating systems (Windows 7, macOS 10.10 or below) and/or 
incompatible graphic cards/drivers may have problems with the resizable user 
interface of version 1.0. Thus, I decided to provide a non-resizable version of the 
Bucket Pops based on the old iPlug framework – this is called the “N” version. It 
should work on almost all machines (even on 32 bit Macs).

Acknowledgments
Big thanks to:

● kraftraum (https://soundcloud.com/kraftraum) who has again designed many 
of the default patches and was again THE Beta tester.

● Oli Larkin and the iPlug/iPlug2 team.

● Laurent Bergman for translating the Full Bucket manuals to French.

And at this point I would also like to say Thank you! to all the people who share their 
information about the Mini Pops-7 via the Internet. Last not least another THANK 
YOU! to the KVR Audio community and to the KORG engineers.

No, I am not affiliated with KORG in what relation ever except that I always find 
myself entangled with their instruments. 
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General Operation
Bucket Pops is a rhythm machine with 20 different rhythm patterns and 15 individual 
instruments. The patterns are 2 bars long (although the second bar of most of the 
patterns is just a repetition of the first bar) and have 64 steps (the original Mini 
Pops-7 had “only” 32; see Editing Steps The Mini Pops Way). 

Mouse Clicking Convention

Many functions of the Bucket Pops are triggered or activated by clicking at various 
buttons or labels in the user interface (UI). Since older Macs mouses may have only 
one button, Bucket Pops uses the following convention:

● “Left Clicking”
Denotes that the left (or single) mouse button is clicked.

● “Right Clicking”
Denotes that the right mouse button is clicked or that the CTRL, ALT, or 
COMMAND key is held while (left) clicking.

Note that this convention applies for the whole manual.

MIDI Learn And The Config File “bucketpops.ini”

Every parameter of the Bucket Pops can be controlled by one MIDI controller. If you 
want to change the assignment of MIDI controller (CC; MIDI Control Change) to a 
Bucket Pops parameter the MIDI Learn function comes in quite handy: Just click the 
LEARN button on the Sound Manager panel and wiggle both the MIDI controller and 
the parameter you want to assign (you can abort MIDI Learn by clicking the button 
again). If you want to unlearn the assignment, right-click the LEARN button (the label 
now reads “UNLRN”) and activate it. Now wiggle the MIDI controller or the parameter 
that you want to unlearn. To save the controller assignments use “Save Configuration” 
in the Options Menu (see below); they are stored in the bucketpops.ini 
configuration file. The exact location of this file depends on your operating system and 
will be displayed when you click on “Reload” or “Save Configuration”.
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Options Menu

When clicking on the OPTIONS button a menu opens with the following options:

Command Description

Copy Program Copy current program to internal clipboard

Paste Program Paste internal clipboard to current program

Init Program Initialize the current program

Load Program Load Bucket Pops's current program from a FXP file

Save Program Save Bucket Pops's current program to a FXP file

Load Bank Load 64 patches from a FXB file into Bucket Pops

Save Bank Save Bucket Pops's 64 patches to a FXB bank file

Select Startup Bank Select the bank file that should always be loaded when 
Bucket Pops is started

Load Startup Bank Load the Startup bank file; can also be used to check what 
the current Startup bank is

Unselect Startup 
Bank

Unselect the current Startup bank

MIDI Thru Set globally if MIDI data sent to Bucket Pops should be 
sent through to its MIDI output

Ignore Program 
Change

Set globally if MIDI Program Change data sent to Bucket 
Pops should be ignored

Reload Configuration Reload Bucket Pops's configuration file

Save Configuration Save Bucket Pops's configuration file

MIDI File… Export the current rhythm pattern to a MIDI file type 0 or 
1 (also see section Import and Export of MIDI Files)

Window Size… Change the window size of Bucket Pops

Save Window Size Stores the current window size to the configuration file so 
that it will be restored on the next loading of Bucket Pops

Check Online for 
Update

When connected to the Internet, this function will check if 
a newer version of Bucket Pops is available at 
fullbucket.de

Visit fullbucket.de Open fullbucket.de in your standard browser
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The Main Page
All controls of the original Mini Pops-7 are placed on the Main Page of Bucket Pops; 
any additional parameters are accessible via the Settings and the Sequence pages.

Selecting Rhythms

Rhythm patterns are organized in two rows: The Top Row (Waltz to Swing) and the 
Bottom Row (Jazz Waltz to Latin Swing). The switch located below the POWER switch 
at the very right is used to flip between the two rows.

You can select a rhythm pattern by clicking one of the white push buttons. Right-
clicking on a button will allow you to select multiple patterns at once.

Note that it is not possible to combine rhythm patterns of different rows – thus, 
Rumba + Habanera is an impossible combination (unless you are willing to re-create 
such a pattern yourself – see section The Sequence Page).

Playing Rhythms

To start or stop the machine just click the “PLAY/STOP” push button or the “PLAY” 
button at the bottom screen. The difference between both button is that the 
“PLAY/STOP” button will reset and start at the beginning of the pattern while the 
“PLAY” button will continue playing from the last position – except if you right-click it.

The TEMPO knob sets the playback tempo. Hovering with the mouse over the knob 
reveals the current tempo in BPM. If the SYNC button is lit, Bucket Pops will 
synchronize playback tempo as well as start/stop to the host DAW. Finally, the 
aforementioned POWER knob disables playback. This might be useful if you want to 
start/stop the machine via parameter automation.
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Level Sliders

The Mini Pops-7 featured extra volume sliders for the instruments Quijada, Guiro and 
Tambourine since they were always playing – even if no rhythm was selected – the 
same pattern, regardless of what rhythm was selected (except for slight variations of 
non-4/4 signature rhythms). Thus it was possible to attenuate or even “mute” these 
instruments.

The “BALANCE” slider adjusts the volume balance between the Base drum and the 
cymbal group of instruments (Hihat, Cymbal 1, Cymbal 2) while the “VOLUME” slider 
does the obvious thing.

The POWER Button

The “POWER” button seems to be a bit useless. However it makes perfect sense to 
automate this button when running the Bucket Pops in sync to your DAW: This way 
you can for example delay the playback or disable it during breaks.

User Rhythm Patterns

Bucket Pops allows you to edit rhythm patterns (see The Sequence Page) – this was 
not possible with the original hardware (at least not with reasonable effort). Once an 
original rhythm pattern is changed, the Main Page symbolizes that with a tape strip 
and the name “USER n” where n is the number of the rhythm (1 to 20).
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The Settings Page
In contrast to many other rhythm machines plug-ins, the Bucket Pops instruments are 
not based on samples of the original Mini Pops but are synthesized in real time and 
can be tweaked in their relevant parameters. This is done using the Settings Page.

Instrument Parameters

The following table lists the various parameters of the 15 instruments (note that not 
all parameters are available for all instruments).

parameter instrument description

TUNE all Frequency of main oscillator or filter

ATTACK all except Guiro Attack time of amplitude envelope

DECAY all except Guiro Decay time of amplitude envelope

RESO Snare 1+2, Cymbal 
1+2, Hihat, Tambourine

Level of filter resonance

TICK Snare 1 & 2 Level of initial attack impulse

HIGHP.
Snare 1+2, Cymbal 
1+2, Tambourine

Frequency of highpass filter

TUNE2

Conga, Cowbell

Frequency of secondary oscillator

LEVEL2 Level of secondary oscillator

DECAY2 Decay time of secondary oscillator

RATE
Guiro, Quijada

Repeat rate of signal pulses

DENSITY Density of signal pulses
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Output Mixer and Note Assignment

The level and the panorama position of all 15 
instruments can be adjusted individually. 
Furthermore, each instrument can be 
assigned to one of 7 “extra” stereo output 
pairs. This is done by clicking on the 
“OUTPUT” button which opens a dedicated 
context menu. It is also possible to keep the 
instrument in or remove it from the standard 
stereo sum output – just check or uncheck the 
“Sum Output” entry of the context menu.

Left-clicking the “NOTE” button triggers the 
respective instrument while right-clicking 
opens another context menu used to assign 
an instrument to a specific (MIDI) note or 
even to turn it off.

The menu entry “Set Middle C” allows you to 
select the notation schema of your choice. The 
idea here is to select which name to use for MIDI note number 60:

● “C3”: Used for example in Cubase, Ableton and Bitwig.

● “C4”: The scientific standard notation; used for example in Reaper and MuLab.

● “C5”: Used for example in FL Studio, Cakewalk and many trackers.

Finally, when you click on the label of an instrument at the very top of the screen, 
another context menu opens where you can rest all instrument parameters or note 
assignments to their defaults.

The Guiro

All instruments are one-shot triggered which means that they only react on Note On 
and ignore Note Off events – except for the Guiro which is gated. Thus, after a Note 
On event the Guiro sounds until a Note Off event is received. This is only partially the 
way how a true Guiro works but exactly the way it is realized in the original Mini 
Pops-7.
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The Sequence Page
On the Sequence Page you can edit the 20 individual rhythm patterns. This is pretty 
straight forward – however, there are some peculiarities due to the nature of the 
original machine.

Editing Rhythm Patterns

The button on the top left denotes the rhythm pattern to edit. By left-clicking this 
button you can select a different rhythm to edit. Right-clicking opens another context 
menu where you can copy the pattern from another rhythm or restore the original 
pattern.

Note that the rhythm pattern you see on the Sequence Page is not necessarily the 
rhythm that Bucket Pops is playing – the rhythms to play are selected on the Main 
Page! If the current rhythm is selected for playing and Bucket Pops is actually playing, 
you will see a green dot at the top row with the step numbers.

Left-clicking inside the event matrix activates or deactivates an event (“beat”) for the 
current instrument and the respective step. Right-clicking opens a context menu 
where you can clear all events of the pattern, just the events of the selected row 
(instrument), or just the events of the selected column (step). You can also use the 
context menu to automatically fill or clear instrument events for various steps (each 
quarter or eighth note etc.). A similar context menu opens when you click on the label 
of an instrument.

Editing Steps The Mini Pops Way

The original Mini Pops-7 had 32 steps (16 steps, 2 bars) while Bucket Pops doubles 
the total number of steps to 64. Each step can be activated or deactivated by clicking 
on the top row of the event matrix showing the step numbers – a deactivated step is 
denoted by a red column.
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To create a 3/4 signature rhythm pattern like Waltz, the Mini Pops-7 skipped steps 
5+6, 9+10, 21+22 and 25+26 during playback. This way it was possible to reuse 
diode matrix patterns that were used by other rhythms, too (diodes are hardware and 
hardware is expensive!).

Bucket Pops emulates this behavior by deactivating steps. However, since the number 
of steps are doubled in Bucket Pops, the skipped (deactivated) steps for Waltz are 9–
12, 17–20, 41–44, and 49–52.

Why does the Bucket Pops follow this (at first glance) weird schema and does not go 
for a simplification? For example, to create a 3/4 signature it would be easier just to 
limit the number of steps instead of skipping steps in between. The answer is that it 
makes a big difference when you combine rhythms (i.e. select more than one rhythm) 
for playback. The classic Oxygene patterns only emerge when the original diode 
matrix behavior is emulated!

Triplets and Templates

The way the Mini Pops-7 reproduced a triplet-based rhythm like Slow Rock is even 
more tricky: Here every fourth step (4, 8, 12, …) was skipped while the overall tempo 
was slowed down by the factor 3/4! In Bucket Pops the button “tripl.” (for “triplets”) 
activates exactly this specific tempo reduction, while in the case of Slow Rock each 
seventh and eighth step are deactivated (see image at the top of this section).

Clicking on the “STEPS” button or right-clicking the top row showing the step numbers 
opens a context menu where you can select a specific template for activated steps.

Activate all steps: activates all steps

Deactivate steps 33 to 64: deactivates the steps 33 to 64

Template for 3/4: deactivates the steps 13 to 16, 29 to 32, 45 to 
48, and 61 to 64 (note that this is a different 
pattern as used for Waltz and Jazz Waltz)

Template for 6/8: deactivates the steps 25 to 32 and 57 to 64

Template for 7/8: deactivates the steps 29 to 32 and 61 to 64

Template for Triplets: deactivates every 7th and 8th step
(same pattern as used for Slow Rock)

Import and Export of MIDI Files

Finally each rhythm pattern can be imported from or exported to a MIDI file.

● For MIDI files based on triplets you have the option to import them as 
Bucket Pops triplet patterns (see section above).

● Rhythm patterns can be exported as MIDI file type 0 (single track) or type 1 
(15 tracks – one track per instrument).

● To export the combined patter of all selected rhythms us the export 
functionality in the Options Menu).
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Parameters

Main Page

parameter ID description

Volume 0 Total volume level

Power 1 Power switch

Tempo 2 Tempo control (bpm)

Tempo Sync 3 Tempo synchronization to host

Quijada 4 Level of instrument “Quijada”

Guiro 5 Level of instrument “Guiro”

Tambourine 6 Level of instrument “Tambourine”

Balance 7 Balance between Base and Hihat/Cymbal 1+2

Rhythm 1–10 8–17 Rhythm selector buttons 1 to 10

Rhythm Row 18 Rhythm row selector switch

Instruments

parameter ID description

Level X 19–33 Volume level of instrument X

Pan X 34–48 Panorama of instrument X

Note X 49–63 MIDI note assignment of instrument X

Base Frequency 64 Frequency of instrument Base

Base Attack 65 Attack time of instrument Base

Base Decay 66 Decay time of instrument Base

Snare 1 Frequency 67 Frequency of instrument Snare 1

Snare 1 Attack 68 Attack time of instrument Snare 1

Snare 1 Decay 69 Decay time of instrument Snare 1

Snare 1 Resonance 70 Resonance of instrument Snare 1

Snare 1 Tick 71 Tick level of instrument Snare 1

Snare 1 Highpass 72 Highpass frequency of instrument Snare 1

Snare 2 Frequency 73 Frequency of instrument Snare 2

Snare 2 Attack 74 Attack time of instrument Snare 2

Snare 2 Decay 75 Decay time of instrument Snare 2

Snare 2 Resonance 76 Resonance of instrument Snare 2

Snare 2 Tick 77 Tick level of instrument Snare 2

Snare 2 Highpass 78 Highpass frequency of instrument Snare 2

Small Bongo Freq. 79 Frequency of instrument Small Bongo
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parameter ID description

Small Bongo Attack 80 Attack time of instrument Small Bongo

Small Bongo Decay 81 Decay time of instrument Small Bongo

Large Bongo Freq. 82 Frequency of instrument Large Bongo

Large Bongo Attack 83 Attack time of instrument Large Bongo

Large Bongo Decay 84 Decay time of instrument Large Bongo

Conga Frequency 1 85 Frequency 1 of instrument Conga

Conga Attack 86 Attack time of instrument Conga

Conga Decay 1 87 Decay time 1 of instrument Conga

Conga Level 2 88 Level of oscillator 2 of instrument Conga

Conga Frequency 2 89 Frequency 2 of instrument Conga

Conga Decay 2 90 Decay time 2 of instrument Conga

Cowbell Frequency 1 91 Frequency 1 of instrument Cowbell

Cowbell Attack 92 Attack time of instrument Cowbell

Cowbell Decay 1 93 Decay time 1 of instrument Cowbell

Cowbell Level 2 94 Level of oscillator 2 of instrument Cowbell

Cowbell Frequency 2 95 Frequency 2 of instrument Cowbell

Cowbell Decay 2 96 Decay time 2 of instrument Cowbell

Claves Frequency 97 Frequency of instrument Claves

Claves Attack 98 Attack time of instrument Claves

Claves Decay 99 Decay time of instrument Claves

Hihat Frequency 100 Frequency of instrument Hihat

Hihat Attack 101 Attack time of instrument Hihat

Hihat Decay 102 Decay time of instrument Hihat

Hihat Resonance 103 Resonance of instrument Hihat

Rimshot Frequency 104 Frequency of instrument Rimshot

Rimshot Attack 105 Attack time of instrument Rimshot

Rimshot Decay 106 Decay time of instrument Rimshot

Cymbal 1 Frequency 107 Frequency of instrument Cymbal 1

Cymbal 1 Attack 108 Attack time of instrument Cymbal 1

Cymbal 1 Decay 109 Decay time of instrument Cymbal 1

Cymbal 1 Resonance 110 Resonance of instrument Cymbal 1

Cymbal 1 Highpass 111 Highpass frequency of instrument Cymbal 1

Cymbal 2 Frequency 112 Frequency of instrument Cymbal 2

Cymbal 2 Attack 113 Attack time of instrument Cymbal 2

Cymbal 2 Decay 114 Decay time of instrument Cymbal 2
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parameter ID description

Cymbal 2 Resonance 115 Resonance of instrument Cymbal 2

Cymbal 2 Highpass 116 Highpass frequency of instrument Cymbal 2

Tambourine Freq. 117 Frequency of instrument Tambourine

Tambourine Attack 118 Attack time of instrument Tambourine

Tambourine Decay 119 Decay time of instrument Tambourine

Tambourine Reso. 120 Resonance of instrument Tambourine

Tambourine Highpass 121 Highpass frequency of instrument Tambourine

Guiro Frequency 122 Frequency of instrument Guiro

Guiro Rate 123 Rate of instrument Guiro

Guiro Density 124 Density of instrument Guiro

Quijada Freq. 125 Frequency of instrument Quijada

Quijada Attack 126 Attack time of instrument Quijada

Quijada Decay 127 Decay time of instrument Quijada

Quijada Rate 128 Rate of instrument Quijada

Quijada Density 129 Density of instrument Quijada
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Frequently Asked Questions

How do I install the Bucket Pops (Windows 32 bit version)?
Just copy the files bucketpops.dll from the ZIP archive you have downloaded to your 
system's or favorite DAW's VST plug-in folder. Your DAW should automatically register 
the Bucket Pops VST plug-in the next time you start it.

How do I install the Bucket Pops (Windows 64 bit version)?
Just copy the file bucketpops64.dll from the ZIP archive you have downloaded to 
your system's or favorite DAW's VST plug-in folder. Your DAW should automatically 
register the Bucket Pops VST plug-in the next time you start it.

Note: You may have to remove any existing (32 bit) bucketpops.dll from your VST 
plug-in folder or else your DAW may screw the versions up...

How do I install the Bucket Pops (Mac VST/AU 64 bit)?
Locate the downloaded PKG package file bucketpops_1_0_0_mac.pkg in Finder (!) and 
do a right- or control-click on it. In the context menu, click on “Open”. You will be 
asked if you really want to install the package because it comes from an “unidentified 
developer” (me ). Click “OK” and follow the installation instructions.

What is the “N” version of the Bucket Pops?
The “N” version is the non-resizable version of the Bucket Pops that should run on 
almost any older Windows or Mac machine. So if you have problems with the standard 
Bucket Pops version, this is the one to go for.

What is the plug-in ID of the Bucket Pops?
The ID is f b p 7 .

How do I know if a new version of the Bucket Pops is available?
When connected to the Internet, open the File menu (see section Options Menu) by 
clicking the disk icon and select the entry “Check Online for Updates”. If a new version 
of the Bucket Pops is available on fullbucket.de the respective information will be 
shown in a message box.

How do I resize the Bucket Pops window?
Just grab the yellow triangle at the bottom right of the Bucket Pops window and drag 
it. You can save the current window size using the menu entry  “Save Window Size” in 
the Options Menu.


	Introduction
	The KORG Mini Pops-7
	The Bucket Pops
	The Bucket Pops “N” Version

	Acknowledgments
	General Operation
	Mouse Clicking Convention
	MIDI Learn And The Config File “bucketpops.ini”
	Options Menu

	The Main Page
	Selecting Rhythms
	Playing Rhythms
	Level Sliders
	The POWER Button
	User Rhythm Patterns

	The Settings Page
	Instrument Parameters
	Output Mixer and Note Assignment
	The Guiro

	The Sequence Page
	Editing Rhythm Patterns
	Editing Steps The Mini Pops Way
	Triplets and Templates
	Import and Export of MIDI Files

	Parameters
	Main Page
	Instruments

	Frequently Asked Questions

